This instructional guide for teachers introduces the Macintosh computer for classroom use, and "The Writing Center," a program to create documents. Information for using the computer and the program to create teaching aids and instructional materials and to instruct students in program use is included. A curriculum outline is provided in the "Using the Macintosh Computer & The Writing Center in the One Computer Classroom" section. A second section, "The Mac Pack: All You Need To Know To Get Started on the Macintosh Computer," covers software policy, windows utilities, menus, using the mouse, and other specifics concerning operating a Macintosh computer. A third section, "A Guide to The Writing Center," contains a guide to sessions for using the program to create newsletters and instructional materials, as well as to teach writing to students. Numerous handouts and transparency masters for the kit are included. (SLD)
Teaching Across The Curriculum
With The Macintosh
&
The Writing Center™
In The One Computer Classroom

By Regina V. Barton
For The UFT New York City Teacher Centers Consortium

A "Keys To Literacy" Project Of The UFT NYCTCC®
# Contents

**Using The Macintosh Computer & The Writing Center™ In The One Computer Classroom**

<table>
<thead>
<tr>
<th>Session</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curriculum Outline</td>
<td>5</td>
</tr>
<tr>
<td>Session 1: Introduction To The Macintosh Computer</td>
<td>6</td>
</tr>
<tr>
<td>Session 2: The Apple Menu &amp; Control Panel</td>
<td>6</td>
</tr>
<tr>
<td>Session 3: Introduction To The Writing Center™</td>
<td>6-7</td>
</tr>
<tr>
<td>Session 4: Creating &amp; Changing Text</td>
<td>8</td>
</tr>
<tr>
<td>Session 5: Using Graphics</td>
<td>8</td>
</tr>
<tr>
<td>Session 6: Using Text &amp; Graphics In A Layout Design</td>
<td>9-10</td>
</tr>
<tr>
<td>Session 7: Review &amp; Guided Project</td>
<td>10</td>
</tr>
<tr>
<td>Session 8: The Writing Process, The Writing Center™ &amp; The Horace Greeley Keys To Literacy</td>
<td>10-11</td>
</tr>
<tr>
<td>Session 9: Administrative Tasks &amp; Claris Works™</td>
<td>11</td>
</tr>
<tr>
<td>Session 10: The One Computer Classroom</td>
<td>11</td>
</tr>
</tbody>
</table>

**The Mac Pack: All you need to know to get started on the Macintosh Computer**

- Software Policy     | 12   |
- Introduction to The Macintosh: The Macintosh® Basics Tour | 13   |
- Turning The Macintosh On | 15   |
- Macintosh Basics™ Tour Information Sheet | 16-17 |
- Quick Reference      | 18   |

**Session 1: Basic Macintosh Operations**

- The Desktop | 19   |
- Time To Get Started | 20   |
- Windows      | 21   |
- Anatomy of A Window | 22   |

**Menu Bars**

- Opening An Item | 23   |
- Closing An Item | 24   |
- The Mouse       | 24   |
- Creating A New Folder | 26   |
- Saving Your Work | 27   |
- Formatting A Floppy Disk | 29-31 |
- The Trash Can   | 31-32 |
- Shutting Down The Macintosh | 33   |
Session 2: The Macintosh Apple Menu

The Finder
Suitcase II
Alarm Clock
Calculator
Chooser
Control Panel
Changing Color of Desktop
Changing Highlight Color
Key Caps
Scrapbook

A Guide To The Writing Center™

Session 3: Introduction To The Writing Center™
Creating A New Document
Launching The Writing Center™
Selecting A Template
The Writing Center™ Window
Parts Of The Writing Center™ Window
Preferences
Page Setup
Saving Your Document
Quitting The Program

Session 4: Creating & Changing Text
Fonts
Reference: The Dictionary & Thesaurus

Session 5: Using Graphics
Choosing A Picture
Moving a picture
Rotating Pictures
Resizing A Picture
Cropping Pictures
Creating Borders Around Pictures
Printing Your Documents

A Guide To The Reading/Writing Connection & The Writing Process: Prewriting, Revision & Editing Strategies For The Classroom

The Reading/Writing Connection

A Guide To The Writing Process: Prewriting, Revision & Editing Strategies For The Classroom
What is The Writing Process?  
Some Simple Ways To involve Students In Writing  
Sample Revision & Editing Checklists From The Writing Center™

<table>
<thead>
<tr>
<th>The Writing Process</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is The Writing Process?</td>
<td>74</td>
</tr>
<tr>
<td>Some Simple Ways To involve Students In Writing</td>
<td>75</td>
</tr>
<tr>
<td>Sample Revision &amp; Editing Checklists From The Writing Center™</td>
<td>78-85</td>
</tr>
</tbody>
</table>

**The Elements Of Design & Layout**

<table>
<thead>
<tr>
<th>Session 6: Elements Of Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. The Reading Process In The Design Of Material OR How People Read Printed Materials</td>
</tr>
<tr>
<td>The Three Stages of Relevancy</td>
</tr>
</tbody>
</table>

**B. Designing Layout**

<table>
<thead>
<tr>
<th>Factors To Consider In Layout Of Material</th>
</tr>
</thead>
<tbody>
<tr>
<td>89-91</td>
</tr>
</tbody>
</table>

*Portfolio Of Projects For The Macintosh Compute & The Writing Center™ In The One Computer Classroom*

<table>
<thead>
<tr>
<th>Session 3: Project # I Part A: CREATING A CLOZE EXERCISE</th>
</tr>
</thead>
<tbody>
<tr>
<td>92</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 4: Project # I II: Creating A &quot;Make A Story Template&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>96</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 5: Project # III: Creating A Mystery Picture - Using The &quot;Visual-Verbal&quot; Connection With Mathematics</th>
</tr>
</thead>
<tbody>
<tr>
<td>97</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 6: Project # IV: Creating A Science Newsletter</th>
</tr>
</thead>
<tbody>
<tr>
<td>98</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 6: Project # V: CREATING A BUBBLE OUTLINE</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 6: Project # VI: The One Computer Classroom</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Handouts &amp; Transparency Masters For The Macintosh &amp; The Writing Center™ In The One Computer Classroom</th>
</tr>
</thead>
<tbody>
<tr>
<td>116</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Administrative Tasks &amp; Claris Works® Review Sheets For The Macintosh Computer &amp; The Writing Center™</th>
</tr>
</thead>
<tbody>
<tr>
<td>107</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 1 Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>108</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 2 Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>109</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 3 Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 4 Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>111</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 5 Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>112</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 6 Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>113</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 7 Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>114</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 8 Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>115</td>
</tr>
</tbody>
</table>

**Reading Patterns**

<table>
<thead>
<tr>
<th>Reading Patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td>117</td>
</tr>
</tbody>
</table>

**Text Design: Working With Type**

<table>
<thead>
<tr>
<th>Text Design: Working With Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
</tr>
</tbody>
</table>

**6 Foundational Concepts of Layout Design**

<table>
<thead>
<tr>
<th>6 Foundational Concepts of Layout Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>121</td>
</tr>
</tbody>
</table>

**3 Stages of Readership**

<table>
<thead>
<tr>
<th>3 Stages of Readership</th>
</tr>
</thead>
<tbody>
<tr>
<td>122</td>
</tr>
</tbody>
</table>

*A "Keys To Literacy" Project Of The UFT NYCTCC®*
USING THE MACINTOSH COMPUTER & THE WRITING CENTER™ IN THE ONE COMPUTER CLASSROOM CURRICULUM OUTLINE

"I can accept and process data, but I have trouble generating it on my own."

This cartoon reprinted from Scholarship, a collection of cartoons from The Kappan

A "Keys To Literacy" Project Of The UFT NYCTCC®
Session I: Introduction To The Macintosh Computer

A. Administrative Tasks
B. The Macintosh Basics® Tour
C. Learned Skills
  • Turning on the Computer
  • Recognizing the Macintosh Desktop
  • Opening & Closing Hard Disk
  • Creating a New Folder
  • Mouse Skills
  • Launching A Program
  • Creating A Document
  • Saving A Document
  • Quitting A Program
  • Emptying the Trash
  • Shutting Down the Computer

Session 2: The Apple Menu & Control Panel

A. Review/Practice
B. Terminology
C. Board Of Education Software Policy
D. The Apple Menu
  • Finder
  • Desk Accessories
    - Alarm Clock
    - Calculator
    - Chooser
    - Control Panel
    - Find File
E. Installing The System
  • Installer Disks
  • Customize Options

BRING IN TWO PIECES OF STUDENT WORK FROM YOUR STUDENTS' LANGUAGE ARTS CLASS FOR NEXT SESSION

Session 3: Introduction To The Writing Center™

A. Review/Practice
B. Samples (Hard Copies)
  • Reports
  • Class Lists
  • Newsletters
  • Cloze Exercises

A "Keys To Literacy" Project Of The UFT NYCTCC®
• Templates
• Awards
C. Document Templates
• Report
• Newsletter
• Custom
D. Menus (Hard Copy)
• File
• Edit
• Text
• Picture
• Reference
• Window
• Help
E. Creating A New Document— Portfolio Project II - A Cloze Exercise: Part A
F. Launching The Writing Center™
• Open The Writing Center™ folder
• Double Click on The Writing Center™ icon to launch program
G. The Writing Center Document Window
• The Ruler
• Text Location Indicator
• Tab Icons
• Line Spacing Icons
• Text Alignment Icons
H. Page Set-Up
• Setting Preferences & Defaults
  - Setting Margins
  - Selecting Page Borders (Not Paragraph Borders)
  - Setting Margins
  - Setting Columns
  - Tabs
I. Saving A Document
• File Menu
  • Save As Dialog Box
  • Select Destination Folder
  • Save to Folder On Hard Disk (1st. Save)
J. Quitting
• File Menu
  • Quit
K. Shutdown

BRING IN TWO PIECES OF STUDENT WORK FROM YOUR STUDENTS' LANGUAGE ARTS CLASS FOR NEXT SESSION

A "Keys To Literacy" Project Of The UFT NYCTCC©
Session 4: Creating & Changing Text

A. Review/Practice
B. Opening A Saved Document
   • Open The Writing Center™ folder
   • Double Click on your document icon
C. Portfolio Project I — A Language Arts Cloze Exercise: Part B
   • Heading Text
   • Body Text
   • Alignment
   • Line Spacing
   • Changing Fonts, Style & Color
   • Border
D. Using the Spell Check
E. Using the Thesaurus
F. Save
G. Saving to Floppy Disk
H. Quitting
I. Shutdown

Session 5: Using Graphics

A. Review/Practice
B. Graphics Importation
   • Open New Document: Portfolio Project II — Make A Story Template (Making the Visual-Verbal Connection)
   • Select Choose A Picture from Picture Menu
   • Resize
   • Crop
   • Border
   • Rotate
   • Flip Sideways
C. Save As Make A Story
D. Quit
E. Shut Down
Session 6: Using Text & Graphics In A Layout Design

A. Review/Practice

B. Stages Of Relevancy – How People Read Printed Material
   - Reading Habits In The Design Of Printed Material
   - Elements of Layout & Design

C. Psychographic Factors In The Layout & Design of A Newsletter
   - Brainstorming Activity (Show sample on overhead & elicit: Would you be interested in this? Why?)
     - Maximum visual suitability
     - Audience appeal
     - Life style factors
     - Value of imagery
     - Conveyance of information
     - Moving to action

D. Creation Of A Newsletter
   - Readability (Research & Statistics)
   - Legibility (Research & Statistics)

E. Open New Document—Portfolio Project III – Mystery Picture

F. Select four questions from the model and Type them in

G. Select appropriate pictures to accompany the questions using the layout & design guidelines

H. Save As To folder on Hard Disk

I. Printing
   - Select Page Preview from File Menu
   - Select Print from File Menu
   - Select Best Grays
   - Click on Print Button with mouse

J. Quitting

K. Shutdown

BRING IN 4 SHORT PIECES OF STUDENT WRITING FROM YOUR STUDENTS' SCIENCE CLASS NEXT SESSION
Session 7: Review & Guided Project
A. Review/Practice
B. "Create Your Own Newsletter" : Portfolio Project IV—Science Class Newsletter
   • Participants will create a Science newsletter using their students' writing and the elements of Layout & Design. Participants will be provided with a template and step by step instructions for creating their own newsletter from scratch.

Session 8: The Writing Process, The Writing Center™ & The Horace Greeley Keys To Literacy Philosophy
A. Practice—Make An Award Participants will be given guided instructions in order to create a writing award.
B. The Reading/Writing Connection
   • Similarities Between Reading & Writing
   • Implications for Teaching
   • Link to Computers
C. The Writing Process
   • Prewriting [Strategies – Handouts]
     - The Bubble Outline
     - The Memory Chain
     - The Time Line
   • Revision (Checklists and Fishbowls)
   • Editing (Checklists)
D. The Writing Center™ Checklists
E. Portfolio Project V—Making A Bubble Outline
   • Designing a layout (Custom Template)
   • Selecting A Graphic (Graphics Importation)
F. Save As To Hard Disk
G. Print
H. Quit

This cartoon reprinted from The Student Body, a collection of cartoons from The Kappan

"How many times must I tell you?
It's 'cat' before 'temple' except after 'slave'."

A "Keys To Literacy" Project Of The UFT NYCTCC©
Session 9: Administrative Tasks & Claris Works™

A. Review/Practice
B. Making Class Lists (Data Base Demonstration)
C. Electronic Grading Book (Spreadsheet Demonstration)
D. Seating Plans (Spreadsheet Demonstration)
E. Getting Parents Involved
   • Invitations
   • Letters (Mail Merge Demonstration)

Session 10: The One Computer Classroom

A. Review/Practice
B. The One Computer Classroom — Portfolio Project VI — Strategies
   • Advantages
   • Disadvantages
   • Strategies
C. Portfolio Sharing
D. Evaluation

"It's a note on a floppy disk from my teacher — too bad we don’t have a computer."

This cartoon reprinted from Scholarship, a collection of cartoons from The Kappan.
THE MAC PACK:
ALL YOU NEED TO KNOW TO GET STARTED ON THE MACINTOSH COMPUTER

A "Keys To Literacy" Project Of The UFT /NYCTCC
© UFT/ New York City Teachers Center
SOFTWARE POLICY

Post This Conspicuously In Your Classroom

NEW YORK CITY PUBLIC SCHOOLS

Joseph A. Fernandez, Chancellor

1. Duplication of copyrighted software is prohibited, except for a single archival copy not to be used simultaneously with the original. Duplication of document is prohibited. The written permission of the publisher must be obtained to use the original software and its back-up simultaneously.

2. New York City Public School computers may not be used to illegally duplicate copyrighted software.

3. Software publishers must be contacted to obtain written permission and procedures for making back-up and multiple copies, other than a single archival back-up.

4. A license from the publisher is required to download or network programs to other microcomputers.

5. The use of illegally duplicated software, however obtained, is prohibited in all New York City Public School facilities.

6. The Principal of each school or the Director of each office is responsible for establishing practices to enforce this policy.

7. This policy must be posted conspicuously in every computer room, and next to computers that are available for staff and student use.

8. Violators of this software policy will be subject to disciplinary action.

Class Discussion Questions:

A. What is a copyright?
B. What other types of materials are copyrighted?
C. Why do you think copyrights exist?
D. How does a person copyright his/her material?
INTRODUCTION

to

THE MACINTOSH:

THE MACINTOSH® BASICS TOUR

A "Keys To Literacy" Project Of The UFT / NYCTCC

The Mac Pack © UFT/ New York City Teachers Center
To Turn The Macintosh LC and the Monitor On:

1. Place your right hand on the back of the Macintosh LC Unit and push the rocker switch up.
2. Place your right hand on the back of the Monitor and push the On/Off Button In.
3. As soon as the computer "boots up" (computerese for loading the operating system), you will hear a chime and see the "Happy Mac Icon" which means that the system is loading. After this the "Welcome To Macintosh" message appears on the screen. The Desktop will appear right after this message.
Get some practice in using the **Mouse** — an input device which is particularly helpful in graphics and desktop publishing programs. Read the directions on the screen for instructions. Record your answers on this sheet.

1. The three essential skills in using the *mouse are:* 

2. Define *dragging:* 

3. What do you do when you run out of room when using a mouse? 

4. What does it mean if a button is *dimmed?* 

5. *Pictures on your desktop are called:* 

6. Where do you put your work that you no longer need? 

7. What three things are on your desktop? 

8. What does the *title bar* of the window show? 

9. What are *application programs?* 

10. Define *insertion point:* 

11. In order to save a document on a disk, you must: 

12. What happens when you type a title after a box is highlighted?
Click On 4. Filing Your Work

13. Related documents are stored together in a ________________
14. Which menu allows you to create a new folder? ________________
15. If more than one window is open, how do you know which is the active window?

16. How do you make an inactive window active? ________________
17. A fast way to close a window is to ________________

Click On 5. More About The Desktop

18. What is a shortcut to open an icon? ________________
19. A gray scroll bar means ________________
20. Two ways to move a scroll bar are ________________
21. To resize a window use ________________
22. A bulging trash icon means ________________
23. How do you retrieve a document from the trash? ________________
SESSION 1: BASIC MACINTOSH OPERATIONS
To Turn The Macintosh LC and the Monitor On:

1. Place your right hand on The back of the Macintosh LC Unit and push the rocker switch up. (FIG. 1)
2. Place your right hand on The back of the Monitor and push the On/Off Button in. (FIG. 1)
3. As soon as the computer "boots up" (computerese for loading the operating system), you will hear a chime and see the "Happy Mac Icon" which means that the system is loading. After this the "Welcome To Macintosh" message appears on the screen. The Desktop will appear right after this message.

THE DESKTOP

The area from which the Macintosh first opens is called the desktop. It is designed to function as an office desktop (FIG. 2). There are folders in which to store documents and other items, application programs which do such things as drawing and wordprocessing and even a trash can to get rid of unwanted documents. The desktop is also the place where the Hard disk is accessed. These items are represented by icons.
**TIME TO GET STARTED**

**ICONS**

The first step is to tell the computer what you want to work with. This involves double clicking on an icon and opening a window. Icons (FIG. 3) are small pictures which represent objects on the Macintosh. Some examples are:

- **Letter (document)**
- **Trash** (The trash can gets rid of unwanted items. Disks can also be ejected through it.)
- **The Writing Center™ (application program)**
- **Macintosh HD** (Hard Disk contains programs, documents and folders)

*Figure 3: Icons*

**WINDOWS**

When you open an icon, the desktop will display a window that shows you what is inside. If you have double clicked on the Hard Disk icon, a window will show you the Directory or list of contents (FIG. 4). If you have double clicked on an application program icon, a window will show what is inside (e.g., the menu bar, rulers, etc...)(FIG. 5). If you have opened a document icon, a window will open to the program application the document was created in and also show the document itself (FIG 6).

*Figure 4: The Macintosh Hard Disk Window*
A Window is simply a way of seeing what is inside of a the Hard Disk, folder or application program. There are many parts to a window which makes it unique. These are the parts of a window (FIG. 7):

A. The Title Bar — The Title Bar appears at the top of the window and shows the name of the window.
B. The Active Lines — These are the horizontal lines at the top of the window which appear when the window is “active”.
C. The Scroll Bars — These are the vertical and horizontal bars at the right and bottom of a window. At either end of these bars are arrows. Clicking on the arrows will scroll the contents up and down and left and right.
D. The Zoom Box — Clicking one on the zoom box, which is located in the upper right-hand corner of a window, will “zoom” the window out so that all of its contents are visible. A second Click will “zoom” the window back in.
E. The Size Box — Clicking Once, Holding and Dragging this box, which is located in the lower right-hand corner of a window, will make the window larger or smaller depending upon which way you are dragging the box.
F. The Close Box — Clicking once on this box, which is located in the upper left-hand corner of the window, will close the window.

The way the contents of any window appear depend on the View chosen in the Desktop menu bar. This will be discussed in the Section entitled The Desktop Menu Bar.
Menu Bars

Menu Bars are located across the top of the Desktop (Fig. 8) and each of the application program (Fig. 9) windows. They contain the commands needed to work on the desktop and in each of the application program.

![Figure 7: Anatomy Of a Window](image)

![Figure 8: The Desktop Menu Bar](image)

![Figure 9: The Menu Bar for Aldus® Pagemaker — A Desktop Publishing Program](image)

Notice that in both Menu Bars there is an apple (In circle). This is the Apple Menu. It appears both on the desktop menu an in the menu bars of every program because it contains items and commands which can be used wherever you happen to be working on the computer. This will be discussed in length in the Section entitled The Apple Menu.
THE MOUSE

You need to select items and move them on the Desktop. You will certainly also need to open and close documents, folders and other items on the Macintosh. This is where the mouse comes in handy. The mouse is an input device which helps in the operation of adding data to the computer. The keyboard is also an input device but it cannot do all of the functions which the mouse can easily perform.

Depending upon which function the mouse is performing, it assumes certain appearances. If you are using it to select, move, open or close, it will appear as an arrow called the pointer (FIG. 10). If you are typing in a wordprocessing program, it will appear as a cursor called the I-Beam (FIG. 11).

![Fig. 10: The Pointer](image1)

![Fig. 11: The I-Beam Cursor](image2)

SELECTING AN ITEM

To perform any work you need to select what you wish to work with or it will not register with the computer. To select a folder, for example, you roll the mouse around until you reach the folder you wish to select then click the mouse button once. The folder will become highlighted — it will change color (FIG 12).

![Fig. 12:Selecting a folder with the pointer](image3)

OPENING AN ITEM

To open an item with the mouse, all you must do is (1) select the item (see above), then (2) double click on the item (press the mouse button twice in rapid succession). You will see the pointer turn into a small watch. This means that the computer is working on opening the item selected. You will then see very briefly the “zoom rectangles” which literally show that the item is opening. The window will appear after this. See FIGS. 13 & 14.

CLOSEING AN ITEM

To close an item, click once on the Close Box in the upper right-hand corner of the window.
Figure 13: Window Zooming Out

Figure 14: Opened Window

A "Keys To Literacy" Project Of The UFT NYCTCC
CREATING A NEW FOLDER

In order to keep your work organized, you need to create folders to store your work in. Even though all of the information on the computer is stored in the hard disk, you might not be able to locate certain document if you do not know where it is.

These are the steps for creating a new folder:
A. Go to File in the Desktop Menu Bar. 
B. Select New Folder then let go of the mouse button (FIG. 25). 
C. A new folder will appear on the desktop (FIG. 26). If the Hard Disk window is open and active, then the new folder will appear there. It will be highlighted and entitled “new folder”. 
D. To rename the folder simply leave it highlighted and type a new name in. 

**NEVER GIVE YOUR FOLDER THE SAME NAME AS A DOCUMENT YOU ARE GOING TO STORE IN IT.**

![Figure 25: New Folder Command](image)

![Figure 26: New Empty Folder](image)

![Figure 27: Naming A New Folder](image)
SAVING YOUR WORK

Use the following steps to save your work:
A. Choose SAVE from the File Menu of the application program you are working in. A Dialog Box will appear. This is the Save Dialog Box (FIG. 28).
B. Type the name you wish to give your work in the space which is highlighted. A cursor will appear.
C. Look at the top of the Dialog Box. There will be a small bar with an Open Folder Icon and the name of the folder which is open (FIG. 29). In the Dialog Box window directly below this bar will appear the contents of that folder. Be sure this is the folder you wish to save your work in. If it is not, then click and hold the bar down and go back to the Macintosh Hard Disk (the icon for this will appear in the bar) and scroll down to see the contents. Select the folder you want and open it (FIG. 30).
D. Click on the Save Button (FIG. 31). Notice that your work name appears in the Title Bar of the Window (FIG. 32).

Figure 28: File Menu & Save

Figure 29: The Save Dialog Box

A "Keys To Literacy" Project Of The UFT NYCTCC
FORMATTING A FLOPPY DISK

In order to prevent losing your work, it is always a good idea to make a "back-up" copy onto a floppy disk. A floppy disk is essentially a piece of cellulose (much like the material used in an audio tape) which is treated and encased in a stiff plastic case. The computer puts information on these disks magnetically. It is not too difficult to damage the media so care must be taken not to place it near a magnetic source or near liquids.

Before a blank disk can begin to store information, it has to mark off storage areas on itself. This process is called formatting or initializing a disk.
FORMATTING A FLOPPY DISK (CONT'D)

**STEPS TO FORMATTING:**

A. Insert disk into the disk drive (always insert the disk metal end first, label side up)

**DESKTOP WILL SHOW**

![Figure 33: The Initialize Dialog Box](image)

This disk is unreadable:
Do you want to initialize it?

- [Eject]
- [Initialize]

B. Click once on the "Initialize Button" with the mouse (FIG.33).

**DESKTOP WILL SHOW**

![Figure 34: The "Two-Sided" Button Dialog Box](image)

This disk is unreadable:
Do you want to initialize it?

- [Eject]
- [One-Sided]
- [Two-Sided]

C. Click once on the "Two-Sided" Button with the mouse (FIG.34).

**DESKTOP WILL SHOW**

![Figure 35: the "Erase Button"](image)

This process will erase all information on this disk.

- [Cancel]
- [Erase]
D. Click once on the Erase Button with the mouse (FIG. 35).

DESKTOP WILL SHOW

Please name this disk:

Untitled

OK

E. Using the keyboard, type in a name for your disk then click once in the "OK Box " with the mouse (FIG. 36).

DESKTOP WILL SHOW IN SUCCESSION

(FIG.37)

Formatting Disk...

Verifying Format...

Figure 37 : Finishing Formatting
Creating Directory...

F. The Final Result is a formatted named disk. A floppy disk icon (FIG.38) will appear on the desktop below the Hard Disk icon.

Fig.38: The Floppy Disk Icon

THE TRASH CAN

The Trash Can is a useful Desktop item. With it you can discard documents and folders you no longer need. You also eject floppy disks from the disk drive through the trash can. These are the following steps for getting rid of unwanted items:
A. Click once on the item you wish to discard. You will see it become highlighted (FIG. 39).
B. Drag the item onto the trash can icon until you see the trash can icon turn color. You will see the outline of the item as it is going into the trash can (FIG. 40).
C. Let go of the mouse button.
D. You will see the trash can icon change: it will appear to be bulging (FIG.41).
E. If you double click on the trash can icon and a window will zoom out just as with a folder or application program. You can see the contents of the trash can (FIG. 42).
F. Go To Special in the Desktop Menu Bar (FIG.43).
G. Select Empty Trash then let go of the mouse button (FIG. 44).
H. The trash can icon will return to normal size because it will be empty (FIG. 45).
THE TRASH CAN

Fig. 39: An item to discard
Fig. 40: The item going into the trash can

Fig. 41: A full trash can

Fig. 42: The trash can window

Special

Clean Up Window
Empty Trash...

Eject Disk
Erase Disk...

Restart
Shut Down

Special

Clean Up Window
Empty Trash...

Eject Disk
Erase Disk...

Restart
Shut Down

Fig. 43: The Special Menu
Fig. 44: Empty Trash

Fig. 45: An empty trash can

A "Keys To Literacy" Project Of The UFT /NYCTCC

The Mac Pack © UFT/ New York City Teachers Center
**SHUTTING DOWN THE MACINTOSH**

Use the following steps when shutting down the Macintosh:
A. Close all windows on the desktop screen (click on the close box in the upper left-hand corner of each open window).
B. Choose *Special* From the Desktop Menu Bar (FIG 46).
C. Click on *Shut Down* with the mouse (FIG 47). You will see a message which says "You may now shut down your Macintosh Safely".
D. Push BOTH the Macintosh LC switch and the monitor switch to the off position (FIG. 48).

---

**Figure 46: Special**

<table>
<thead>
<tr>
<th>Menu Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Up Desktop</td>
</tr>
<tr>
<td>Empty Trash...</td>
</tr>
<tr>
<td>Eject Disk</td>
</tr>
<tr>
<td>Erase Disk...</td>
</tr>
<tr>
<td>Restart</td>
</tr>
<tr>
<td>Shut Down</td>
</tr>
</tbody>
</table>

**Figure 47: Shut Down**

<table>
<thead>
<tr>
<th>Menu Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Up Desktop</td>
</tr>
<tr>
<td>Empty Trash...</td>
</tr>
<tr>
<td>Eject Disk</td>
</tr>
<tr>
<td>Erase Disk...</td>
</tr>
<tr>
<td>Restart</td>
</tr>
<tr>
<td>Shut Down</td>
</tr>
</tbody>
</table>

---

**Back Of Monitor**

- **On/ Off Button For Monitor**

**Back Of Macintosh LC**

- **On/ Off Rocker Switch For LC**

---

*Figure 48: To turn off the computer go to the back of the Macintosh & the monitor*
SESSION 2: CUSTOMIZING THE DESKTOP WITH THE APPLE MENU

A "Keys To Literacy" Project Of The UFT / NYCTCC

Page 34

The Mac Pack © UFT/ New York City Teachers Center
SESSION 2: THE MACINTOSH APPLE MENU

The Apple Menu appears in every single window on the desktop and in every application. Here is a description of the functions of the various commands and Desk Accessories in the Apple Menu.

- Located at the top of the desktop — Apple symbol at the beginning of the menu (FIG. 15)
- Place the pointer on the Apple symbol
- Place finger on the mouse button — drag down to the Finder — release button

(FOLLOWING APPEARS)

Figure 15: The Apple Menu

The Finder

- Specific information about your computer (FIG. 16)
- RAM — Total memory in the computer
  1024K = 1 M

Figure 16: About The Finder

A "Keys To Literacy" Project Of The UFT NYCTCC
**SUITCASE II**

- Adds fonts to the system

**ALARM CLOCK**

- Displays the current time on the system
- Alerts you to a predetermined time

![Figure 17: The Alarm Clock](image)

**To Set Alarm**

A. Click alarm clock icon (FIG. 17)
B. Pointer becomes crosshair
C. Move button up — alarm clock icon appears to be ringing
D. Set time
E. Click alarm clock close box
F. Alarm will sound once — Apple Menu Icon will flash between Apple & Alarm Clock
G. Open alarm clock and turn clock off

**CALCULATOR**

(FIG. 18)

- Allows you to do calculations
**CHOOSER**

- Tells the computer which printer will be used (FIG.19)

![Chooser window with printer options](image)

**Figure 19: The Choose**

To select a printer type:

A. Select Chooser from Apple Menu
B. Click on icon for the type of printer
C. Select printer port (where printer is plugged in — back of computer)
D. Click Chooser's close box

**CONTROL PANEL**

*(FIG 20)*

- Selects color of desktop
- Sound adjustment
- Date
- Corelation between mouse & pointer

---

A "Keys To Literacy" Project Of The UFT NYCTCC
CHANGING COLOR OF DESKTOP

- Select Control Panel from Apple Menu
- Select color of choice
- Color in grid screen dot by dot
- Click on none grid screen

CHANGE HIGHLIGHT COLOR

- Select Color Palette on left side of Control Panel
- Click on Change Color (FIG.21)
- Highlight color dialogue box appears (FIG.22)
- If color wheel is entirely black, raise scroll box to the top of scroll bar

Figure 20: The Control Panel
Figure 21: Change Highlight Color

Figure 22: The Color Wheel
CHANGE HIGHLIGHT COLOR (CONT'D)

- Click on color of choice
- Click on the Okay Button
- Click on Hard Drive Icon

FIND FILE

- Choose Find File from the Apple Menu (FIG. 23)
- Type the name of the item you want to locate
- Click the Search Button

![Find File Dialog Box](image)

Figure 23: Find File Dialog Box

KEY CAPS

- Standard and optional characters produced when Shift & Option keys on keyboard are pressed

TO SELECT CHARACTERS

- Select Key Cap from Apple Menu
- Select Key Cap from the Key Cap Menu
- Select Font
- Press either Shift or Option key on keyboard

A "Keys To Literacy" Project Of The UFT /NYCTCC
SCRAPBOOK

- Storage place for text and images that are used frequently (FIG. 24)
- Cannot change scrapbook item

To Save To Or Copy From Scrapbook

- Select material you want to copy
- Choose copy from the Edit Menu
- Choose Scrapbook from the Apple Menu
- Choose Paste from the Edit Menu
- Click on Scrapbook close box

Figure 24: The Scrapbook
A GUIDE TO
THE WRITING CENTER™
SESSION 3: INTRODUCTION TO THE WRITING CENTER™
CREATING A NEW DOCUMENT

To create a new document in The Writing Center, you must follow these steps:

A. Launching The Writing Center™

Double click on the Writing Center™ folder to open it. You will see various items including The Writing Center™ program icon. Double click on the program icon to launch or open the program. You will soon see The Writing Center™ Logo Box and hear a short piece of music. After this, the Layout Template Box will appear.

![The Writing Center™ Folder](image)

![The Writing Center™ Program Icon](image)

Figure 1: The Writing Center™ Folder

Figure 2: The Writing Center™ Program Icon

![The Writing Center™ Logo Box](image)

Figure 3: The Writing Center™ Logo Box

B. Selecting A Template

In order to create a document such as a newsletter, you need to work with a template (a pre-made pattern to which you will add text and pictures). To select a layout template, double click on one of the three choices which appear in the Layout Template Dialog Box. The icon of the template you chose will become highlighted. If you chose the Report Template or the Newsletter Template, a second more specific Layout Template Dialog Box will appear. This box will ask whether or not you wish to have a heading on the template. Click on one of the two selections to choose.
D. The Writing Center™ Window

After selecting the appropriate template, an untitled document window will appear. Figure 6 (below) shows the window for a Report With Heading Template.

Figure 6: A Writing Center Window For The Report With Heading Template

A "Keys To Literacy" Project Of The UFT/ NYCTCC©
PARTS OF THE WRITING CENTER™ WINDOW

As with every window shown on the Macintosh computer, there are many elements which are similar in The Writing Center™ windows. There is:

The Title Bar — in which the name appears (new documents are always named Untitled 1 until the first Save)
The Active Lines — which tells that the window is the one currently being worked in.
The Scroll Bars — which helps to move the page up, down, left and right.
The Zoom Box — which zooms the window in and out to reveal its contents.
The Size Box — which increases or decreases the size of the window.
The Close Box — which will close the current window but not the program.

However, The Writing Center™ has many functions. It can create and import text, import pictures and arrange these items in a page layout to create newsletters, flyers and reports. To perform these functions, the windows in The Writing Center™ must have certain items which other windows on the desktop or in other programs may not have. These items are (FIG. 7)

The Ruler — (located at the top of the window) The ruler is used to set margins and tabs.
Tab Icons — (located on the ruler) These set tabs or measured spaces.
Text Alignment Icons — (located on ruler) These align text to the right, left, center or to both sides of a column or page.
Single and Double Spacing Icons (located on ruler) These set line spacing to single or double.
The Text Location Indicator (located at the bottom left-hand side of the window next to the horizontal scroll bar) This icon tells whether text is being typed into the heading of a document or in the body of a document.

Figure 7: The Writing Center™ window
PREFERENCES

After you have opened a new document you need to set all the defaults (specific settings you wish to include in your document such as margin sizes, fonts and tabs). When you purchase any program, the defaults are set at the factory but you can change these to your own specifications for each document you create. This is true of The Writing Center™ also. An example of the defaults which are set at the factory is the music you hear when the program is launched. You can reset the default so that the music does not play.

The list of these defaults can be set through Preferences, which may be found under the Edit Menu. When you open a new document in The Writing Center™, the ruler may or may not be showing depending on the factory default. When you select Preferences, a dialog box will appear which offers you certain options to select. There is a list of items with a small box next to each. If there is an "x" in a box next to an item, it mean that this item has been selected. These are the items which can be selected in the Preferences Dialog Box (FIG 8):

A. **Ruler Measurements** — This allows you to set the ruler measurement system in inches, centimeters, picas (pressman’s measure which is equal to 1/6 of an inch) or points (pressman’s measure which is equal to 1/72 of an inch). Points will be discussed in more detail in the section entitled FONTS.

B. **Sound** — If this default is set, the music which you heard when you launched the program will play.

C. **Show Ruler** — Selecting this default will put a ruler at the top of your document.

D. **Show Invisibles** — When this default is selected, all of the returns and new paragraphs will appear on your document.

E. **Convert Color Pictures To Black & White On Screen** — When chosen, this default will turn any picture you import into your document into a black and white picture. The purpose of this is so that you can see what it will look like when printed on a black & white printer.

F. **Set Default Picture Folder** — This default allows you to select the folder of pictures you wish to use as the primary source of pictures for your documents. Since The Writing Center™ comes complete with nearly 200 high quality graphics, you can select this folder as your default folder for pictures.

![The Preferences Dialog Box](image)

Click on your choices. Then click on OK.

Figure 8: The Preferences Dialog Box

A "Keys To Literacy" Project Of The UFT/ NYCTCG®

Page 47

The Writing Center™ Guide
**PAGE SETUP**

Once you have set the Preferences, you have taken the first step in completing your document. However, before any text or pictures can be added, you must set some very important page and text defaults. These defaults are set through the Page Setup command in the File Menu (FIGS 9 & 10).

When the Page Setup Dialog Box (FIG. 11) appears, you will notice that it contains many defaults for two specific operations — Page Layout and Laser Writer Page Setup (Printing). Printing will be discussed in the section called Printing Your Documents.

The defaults to be set in Page Setup are divided into three categories — Page Layout, Columns and Margin Settings.

A. **Page Layout.** — Three defaults are set within this category: Document Heading, Page Numbers, Lines Between Columns and Borders (This is accessed through the Borders Button).

   1. **Document Heading.** — This default can be set to add a heading which is separate from the body of the document. You can use this area to place a Newsletter Title or Nameplate with a Logo.

   2. **Page Numbers.** — This default sets the page numbering for the document starting with Page 1.
PAGE SETUP (CONT'D)

3. **Lines Between Columns** — This default puts lines between the columns in a document. If you have chosen columns and this option, when you print out, there will be lines between the columns.
4. **Borders** — This default allows you to place a border around all sides or some sides of your document. The lines vary from hairline (very thin) to triple lines. The style of border can vary from solid (black) to shadow, which gives the impression of a 3-D image. The Border default is accessed by pressing the Border Button in the Page Layout Category of the Page Setup Dialog Box. A Border Dialog Box will appear.

B. **Columns** — This option divides your document into columns. You can divide a document into four columns at most.

C. **Margin Settings** — This default allows you to create custom margin sizes. The factory default is 1 inch around all sides.

---

**LaserWriter Page Setup**

- **Paper:**
  - US Letter
  - A4 Letter
  - US Legal
  - B5 Letter
  - Tabloid

- **Reduce or Enlarge:**
  - [ ]

- **Orientation:**
  - [ ]

- **Printer Effects:**
  - [ ] Font Substitution?
  - [ ] Text Smoothing?
  - [ ] Graphics Smoothing?
  - [ ] Faster Bitmap Printing?

---

- **Page Layout**
  - [ ] Document Heading
  - [ ] Page Numbers
  - [ ] Line Between Columns

- **Columns**
  - [ ] 1 Column
  - [ ] 2 Columns
  - [ ] 3 Columns
  - [ ] Other

- **Margin Settings**
  - Top: 1.00
  - Bottom: 1.00
  - Left: 1.00
  - Right: 1.00

Click on your choices. Then click on OK.

---

Figure 11: The Page Setup Dialog Box
SAVING YOUR DOCUMENT

At this point, after having set the page and ruler defaults, it is wise to save your new document. As a general rule, it is a good idea to save your work every five minutes in order to avert a disaster such as a sudden energy surge through the computer which may wipe out all of your work.

When saving a document for the first time, you must follow these steps:

A. Save As

Choose the Save As Command which is found in the File Menu (FIGS. 12 & 13). A Save As Dialog Box will appear (FIG 14).

B. Naming Your Document

A highlighted box with the words "Untitled 1" will appear in the Save As Dialog Box (FIG 15). Simply begin to type the name you wish to give to your document. The cursor will already be in the highlighted box.

C. Checking The Destination Folder

Before you actually Save As, you must be absolutely sure of where you are saving this document because the Hard Disk may contain many folders. In order to do this, you look at the Open Folder Bar over the window which will show either the Hard Disk contents (if no folders are open) or the contents of whatever folder might be open. On the Open Folder Bar, there will be an Open Folder Icon with the name of the folder beside it. If the open folder is the one you want, then just click once on the Save Button. If the open folder is not the one you want, then click on and hold down the Open Folder Bar and go back to the Hard Drive. From there, you can scroll down the Save Window and locate your folder, then you can press the Save Button (FIG 16). After pressing the button, you will see the name of the document you just saved in the Save Window.

---

Figure 12: The File Menu

Figure 13: The Save As Command
QUITTING THE PROGRAM

When you are finished working with a document, you Save and Quit.
These are the steps for Saving and Quitting:

**A. Save**
Go to the File Menu and select Save. You will see a small watch appear. The File Menu will be highlighted. When the File Menu return to normal color, the document is saved.

**B. Quitting The Program**
Go to the File Menu and select Quit. The document window will disappear and you will return to the desktop (FIGS. 18 & 19).

**C. Shut Down**
Go to the Special Menu and select Shut Down. A message will appear saying "You may now shut off your Macintosh safely." Push the monitor and Macintosh LC buttons (located in the back of the machine) to the "off" position.

![Figure 18: The File Menu](image1.png)
![Figure 19: The Quit Command](image2.png)

"Keys To Literacy" Project Of The UFT & CTCC®

The Writing Center™ Guide
SESSION 4: CREATING & CHANGING TEXT

FONTS

In Session 3, a new document was created, defaults (settings) were set and the document was saved. In this session, text will be created and changed in the document.

Text may be added to two different areas of a document — the heading (top part of the page in which a nameplate or logo is found) and the body (where the stories are found). These are the steps you must take to type text into a document.

A. Check for the insertion point

The insertion point is a short blinking vertical line which appears on the page after you have opened a document. The insertion point tells you where you may start typing. You can move the insertion point simply by clicking once with the mouse on a different part of the page.

B. Typing in the Heading

Make sure the insertion point is in the heading. If it is not, then click once with the mouse in the heading and it will appear. You can also tell what part of the page you are typing in from the text location box. This box, in the lower left-hand side of The Writing Center™ document window. It will either say "body" or "heading" depending upon where you are typing.

![Figure 20: The Font Dialog Box](image)

Click on your choices. Then click on OK.
C. Typing in the Body

Make sure the insertion point is in the body. If it is not, then click once with the mouse in the body and it will appear. You can also tell what part of the page you are typing in from the text location box. This box, in the lower left-hand side of The Writing Center™ document window. It will either say "body" or "heading" depending upon where you are typing.

Changing The Appearance of the Text

There are several ways to change the appearance of text. You can change the Font (typeface), Style (e.g., bold), Color, Alignment and Spacing. One change in any of these features of your text can create a different effect. In The Writing Center™, these features can be changed one at a time or all at once.

A. Changing the Font

To change the font or typeface, highlight the text you wish to change by dragging the mouse over it, then select Font from the Text Menu. A Font Dialog Box will appear. There will be a selection window for Fonts, Size and Style. A Font View Box will show you what the text will look like when you change it. Click on one of the fonts choices. It will appear in the Font View Box. Click on a size choice. It will appear in the Font View Box. Click on as many styles as you want (be careful, though because you may create a distracting font). It will appear in the Font View Box. Press the Okay Button when you are finished.

B. Changing Text Alignment

Text alignment means where the text is lined up between the margins. There are four ways to line text up:

1. Right Alignment — the text is even and up against the right margin while the left side of the text looks ragged.
2. Left Alignment — the text is even and up against the left margin while the right side of the text looks ragged.
3. Center Alignment — the text is up against no margin and sides of the text looks ragged.
4. Justified — the text is even and up against both margins and both sides of the text looks smooth and even.

To Align Text

1. Select Alignment from the Text Menu. An Alignment Dialog Box (FIG.21) showing the choices will appear. Click on your choice, then press the Okay Button when you are finished.

OR

2. Click on one of the Alignment Icons located on the ruler.
G. Line Spacing
To set the distance between lines of text at single or double, click on one of the Line Spacing icons located on the ruler.

Other Ways To Change Text

H. Text Borders
In The Writing Center™, you can wholly or partially border a sentence or paragraph. To do this, you select Border from the Text Menu and click on which sides you wish bordered. You can also select the type of border and line you want.

REFERENCE: THE DICTIONARY & THESAURUS

A. The Dictionary
A handy way to correct misspellings is to use the Spell Checker. To check the spelling, you select Check Spelling from the Reference Menu and click on the Start Checking Button. If you only wished to check one word or one block of text, then highlight what you wish to check before selecting Check Spelling.
REFERENCE (Cont'd)

B. The Thesaurus
The Writing Center™ comes equipped with a 220,000 synonym Thesaurus. To use this feature, highlight a word you need a synonym for, select Thesaurus from the Reference Menu and it will provide a synonym for the word you selected.

After each major change, it is recommended that you save your work. Another good idea is to back it up on a floppy disk.

To Save
A. Select Save from the File Menu. Check to see where you are saving it. Then press The Okay Button. You do not need to name it because you did that in the first save.
B. Insert a formatted floppy disk (metal side first with the round opening facing down) into the disk drive.
C. Select Quit from the File Menu.
D. The program will close. If the document is in your file folder, click on the folder icon and drag it to the Floppy Disk Icon until the Floppy Disk Icon turns black. A Copy Dialog Box appears telling you that the document is being copied into the floppy disk.
E. Eject the Disk by dragging it to the trash can icon. The icon will turn black and the disk will pop out of the disk drive.

DOING THIS WILL NOT HARM ANY INFORMATION ON THE DISK.

Figure 23: The Spell Checker

Figure 24: The Thesaurus

A "Keys To Literacy" Project Of The UFT NYCTCC®
SESSION 5: USING GRAPHICS

Graphics make any kind of reading materials more interesting and comprehensible. The Writing Center™ has nearly 200 high quality graphics in various categories such as people, food and school.

These graphics can be imported (placed) into a Writing Center™ document. These are the steps you must take in order to place graphics in a document:

A. Choosing A Picture

1. Click in the part of the document where you want a picture to go (heading or body).
2. Go to the Picture Menu and select Choose A Picture. The Writing Center™ picture file will open automatically* and you will see a Choose A Picture Dialog Box.

B. Selecting A Picture from the Choose A Picture Window

The Choose A Picture Dialog Box (FIG.25) has a window in which a picture will appear as soon as you select one. To select a picture you need to look at the contents of the Picture Folder in the Directory Window to the right of the Choose A Picture Window. Above this Directory Window there is a pop-down Menu bar. This window is very similar to the Save Window. You need to select from one of the folders a picture you wish to use.

1. You will click open a folder.
2. You will click on the name of a picture and it will appear in the Choose A Picture Window.
3. You will click on the Place In Document Button
4. The picture will be placed in the upper left-hand corner of the document. You will probably wish to move it.

C. Changing A Picture

You can change pictures in many ways. You can move, rotate, flip, resize, crop and border a picture.

In order to make any changes to a picture, you must select (highlight) it first. There are two places to work with pictures — the heading and the body. You cannot move a picture from the heading to the body and vice versa.

* In Session 3, The Writing Center™ picture folder was set as the Default Picture Folder when the Page Setup Defaults were set. This means that when you select Choose A Picture from the Picture Menu, this picture folder will automatically open.
SESSION 5: USING GRAPHICS (CONT’D)

Selecting Pictures

To Select A Picture In the Heading

1. Click in the Heading
2. Choose Work With Heading Pictures

Choose a Picture

3. All the pictures in the heading will be selected. This means that you will see eight dots or “handles” appear around the picture.

4. To work with only one picture, click on the pictures you do not want to work with. This will “deselect” the picture and the handles will disappear.

To Select A Picture In the Body

1. Click on the picture you want. Eight dots or “handles” appear around

A "Keys To Literacy" Project Of The UFT NYCTCC®
SESSION 5: USING GRAPHICS (CONT'D)

To Select More Than One Picture in the Body
1. Hold down the Shift Button located on the keyboard
2. Click on the other picture(s) you want. Eight dots or "handles" appear around all the pictures selected.

To Deselect More Than One Picture in the Body
1. Hold down the Shift Button located on the keyboard
2. Click on the other picture(s) you want to deselect. To deselect all of the pictures, click on something other than the pictures. The Eight dots or "handles" (FIG.26) disappear from around all the pictures.

Figure 26: A picture showing the Edit Handles

Moving Pictures
To move a picture, you can either
1. Drag it to another spot OR
2. Copy, Cut, and Paste it.

To Move a Picture by Dragging
1. Select the picture you want to move.
2. Place the pointer (which will turn into an arrow near any picture) on the picture. Do not place the arrow on any of the handles because you will pull the picture out of shape.
3. Drag the picture to a new spot. The text in the body will move to make room for the picture.

To Move a Picture by Copying, Cutting, and Pasting it.
1. Select the picture you want to move.
2. Go to the File Menu and select Copy. This will copy the picture to the clipboard.
3. Go to the File Menu and select Cut. This will cut the picture from its present position.
4. Move pointer to where you want the picture to go. Click once.
5. Go to the File Menu and select Paste. This will paste the picture in the spot you clicked.

Rotating Pictures

To Rotate A Picture
1. Select the picture you want to turn.
2. Choose Rotate the Picture Menu..
3. Each time you choose Rotate the picture makes a 45 degree turn to the right. Keep selecting Rotate until the picture is the way you want it.
**Session 5: Using Graphics (Cont'd)**

**Resizing A Picture**

Sometimes a picture may not be the size you want. You can **resize** the picture (make it larger or smaller).

There are two ways to resize a picture:
1. Directly on the page using the mouse.
2. Use the **Resize Picture Dialog Box**.

**To Resize A Picture Using The Mouse**

1. Select the picture.
2. Click on the bottom and top "handles" to change the height of the picture.
3. Click on the side "handles" to change the width of the picture.

**To Resize A Picture Using The Resize Dialog Box**

1. Select the picture.
2. Choose **Resize Picture** from the **Picture Menu**. A **Resize Picture Dialog Box** will appear.
3. Select any of the options shown by clicking on the radio buttons.

![Figure 27: Resizing a picture with the mouse](image)

![Figure 28: The Resize Dialog Box](image)

* "Keys To Literacy Project Of The UFT NYCTCC®

Page 60*
**SESSION 5: USING GRAPHICS (CONT'D)**

**Cropping Pictures**

Sometimes you may want to use only part of a picture. In this case, you can crop it. There are two ways to crop a picture.

1. Directly on the page using the mouse **OR**
2. Use the Crop Picture Dialog Box.

**To Crop A Picture Using The Mouse**

1. Select the picture you want to crop.
2. Move the tip of the pointer arrow onto one of the edit "handles" around the picture (FIG. 29).
3. Press and hold the Option button on the keyboard.
4. Drag the handle toward the center of the picture to crop.
5. Drag the handle out from the center to reveal the hidden part.
6. To leave white space around the picture, pull the handle past the original edge of the picture.

**To Crop A Picture Using The Crop Dialog Box**

1. Select the picture you wish to crop.
2. Choose Crop Picture from the Picture Menu. A Crop Picture Dialog Box will appear (FIG. 30).
SESSION 5: USING GRAPHICS (CONT'D)

3. Four edit handles will appear around the picture in the box.
4. Move the tip of the pointer arrow onto one of the edit "handles" around the picture.
5. Drag the handle toward the center of the picture to crop (hide picture)
6. To leave white space around the picture, pull the handle past the original edge of the picture.
7. Select the Done Button when finished.

Creating Borders Around Pictures

1. Select the picture around which you want a border.
2. Choose Border from the Picture Menu. A Picture Border Dialog Box will appear.
3. When the Dialog Box appears, all four border sides are check. You can customize to put borders around only one or two sides of a picture.
4. Select the type of line you want.
5. Select the border style you want.

![Picture Reference Window Help]
- Choose a Picture...
- Resize Picture...
- Crop Picture...
- Border...
- Rotate
- Flip Sideways
- Work with Heading Pictures

Figure 31: The Picture File

Figure 32: A bordered picture
PRINTING YOUR DOCUMENTS

In Session 2 of The Mac Pack (page ), you learned about the Chooser, which helped you to select the correct printer. To actually print within The Writing Center™, you must go to the File Menu, select Print and the Print/Page Setup Dialog Box will appear (FIG.33). Notice it is the same box which appeared after selecting Page Setup (Session 3). To Print, you must
A. select the number of copies you want (type in)
B. Select Best Grays.
C. Select Color/Grayscale.
C. Click on the Print Button.

Figure 33: The Print Dialog Box
A GUIDE TO THE READING / WRITING CONNECTION & THE WRITING PROCESS

PREWRITING, REVISION & EDITING STRATEGIES FOR THE CLASSROOM

A "Keys To Literacy" Project Of The UFT/NYCTCC®
AGENDA

BRAINSTORMING

WHAT IS THE READING-WRITING CONNECTION?

WHAT DO THE EXPERTS SAY?

IMPLIEDATIONS FOR TEACHING?

CONNECTION MAP

GROUP ACTIVITY

LINK TO COMPUTERS

A "Keys To Literacy" Project Of The UFT/NYCTCC
OUTCOMES

What you will learn............
What Is the reading-writing connection?
What do the experts say about this connection?
Implications for the classroom.

What you will do............
• Use the computer to create reading-writing connected lesson?
• Create content area reading-writing activities based on grade level.
BRAINSTORMING

Respond to the following questions:

1. How are reading and writing similar?
2. How can computers be used in the teaching of reading and writing?
3. How does reading stimulate writing?
4. How does writing stimulate reading?
5. How can the creation of student publications facilitate the reading/writing process?
The Reader: Reconstructs Another's Meaning (Comprehends)

The Writer: Constructs Own Meaning (Composes)

Thoughts that occur to both Reader & Writer
- Each constructs and reconstructs personal meaning
- Each develops understandings of a concept
HOW ARE READERS AND WRITERS SIMILAR?

BOTH:

- ARE fostered by the learner's desire to communicate
- INVOLVE prior knowledge of individuals
- INVOLVE interaction with printed material
- ATTEMPT to make sense of the world in a search for meaning
- USE the whole language for constructing meaning (see relationships between words in sentences, see words in context, rather than in fragments)
- ARE pragmatic (guided by a sense of audience)
- ARE cognitive in nature (affect the thought processes)
"Better writers tend to be better readers (of their own writing as well as the writing of others) and better readers tend to produce more syntactically mature writing then poorer readers do."


"To learn to write, children must read in a special kind of way....To learn how to write for newspapers, you must read newspapers, to write poetry, you must read poetry, to write memos you must read them."

— Frank Smith Joining The Literacy Club p.20
TEACHING IMPLICATIONS

- Reading and writing activities promote thinking and learning
- In both, we teach and learn concepts.
- Reading and writing, extend the range of textual interaction in different subject areas.

THE READING /WRITING CONNECTION

- Build Upon Prior Knowledge And Experience
- Critical Thinking (Comprehension Application)
- Develop Vocabulary
- Across The Curriculum

A "Keys To Literacy" Project Of The UFT/NYCTCC®
READING-WRITING CONNECTIONS AND THE USE OF THE COMPUTER

The computer is a tool for the following activities:

1. COMPOSING TEXT - THE CREATIVE PROCESS

2. REVISING AND EDITING - THE WORD PROCESSOR HELPS THE LEARNER TO MOVE LANGUAGE EFFICIENTLY IN ORDER TO MAKE CHANGES.

3. COLLABORATION AND COOPERATIVE LEARNING - LEARNERS CAN HAVE THE OPPORTUNITY TO CREATE TEXT WITH THE COMPUTER FOR SHARING WITH OTHERS AS IN: GROUP REVISION READ AROUNDS AND RESPONSE GROUPS! STUDENTS MUST COMPOSE WITH THE READER IN MIND.

4. COMPREHENSION - THE COMPUTER CAN BE USED TO FRAME THOUGHTS BY EXPERIMENTING WITH TEXT STRUCTURES. STUDENTS CAN REORGANIZE A STORY OR HIGHLIGHT KEY IDEAS WITH THE USE OF GRAPHIC ORGANIZERS. THEY CAN ALSO FORMAT NEWS ARTICLES AND STORIES.

A "Keys To Literacy" Project Of The UFT/NYCTCC®
A GUIDE TO
THE WRITING PROCESS
PREWRITING, REVISION & EDITING STRATEGIES FOR
THE CLASSROOM

A "Keys To Literacy" Project Of The UFT/NYCTCC®

Page 74

The Reading Writing Connection
WHAT IS THE WRITING PROCESS?

The Writing Process is a three step operation in which the writer prepares to write, reads carefully what he has written and organizes and refines his expression and edits the technical language errors. These stages are known as
1. Prewriting
2. Revision
3. Editing

PREWRITING

There are many prewriting strategies which help precipitate thoughts and feelings necessary for good writing. These can be broken down into two basic categories:
1. Logs/Journals — in which the writer collects his thoughts about issues, speculates about literary characters or situations or examines his/her own feelings and ideas about his/her own writing.
2. Graphic/Mapping Techniques — These strategies, such as Semantic Mapping and The Memory Chain render thoughts and organize ideas in a visual manner

SOME SIMPLE WAYS TO INVOLVE STUDENTS IN WRITING

A. Literature Logs. — Students keep a running log which lists questions, feelings, ideas about characters or situations in a piece of literature they are reading.

B. Sentence Starters. — Students freewrite (write without stopping or correcting for approximately 5 minutes) using the beginning of a sentence to start. For example, "Sometimes I feel...", "Tests make me..."

C. The Memory Chain. — Have the students look around the room. Say to them, "write down the name of something in this room which reminds you of something or somewhere or someone else. Draw an arrow after that object's name. After the arrow write down the thing or place or person it reminds you of. Keep going. Create a chain of things you are reminded of." After about 2-3 minutes, say, "Now circle one of those items in your chain and write about it for 5 minutes.

   For example: lamp———living room———Aunt Sylvia———fur coat....

D. Semantic Mapping — is a graphic way to narrow a topic and organize thoughts. The writer begins with a word or a person or place at the top of the map. He or she then proceeds to break that item down into characteristics or categories. After this, the writer will select one of the narrowed-down items as a topic for writing. For example:

   Grandmother
   
   Good cook  held many types of jobs  had 5 children  lived to age 97

A "Keys To Literacy" Project Of The UFT/NYCTCC®
E. **The Bubble Outline** — An organizing strategy in which the students organize paragraphs according to topic and sub-topic. Write a word in the middle of the black board. Invite two students up to the board to serve as secretaries. Ask the class, "What words go with the word on the board?" They call out words which the two student secretaries have to write down wherever they are told on the board. After about 5 minutes, you circle one of the words and say, "What other words go with the one I circled?" Words which belong together are circled in one color of chalk. When other categories appear, they are circled in different colors. The rule is one category—one color.

**REVISION STRATEGIES**

Revision is a combination of careful reading and analysis of a piece of writing in order to evaluate whether or not it makes sense, has a logic to its organization and reaches the intended audience. This stage of the writing process is perhaps the lengthiest because it may take many drafts to reach the level of organization and comprehension which the writer had intended. Here are some strategies to help in the revision process:

1. **Revision groups** ("fishbowls") — These are groups of four in which each member will read his/her piece. One person acts as a recorder to record the suggestions, questions and comments of the commentators. The recorder gives the sheet of suggestions to the writer so that the revisions may be made to the piece of writing. Two persons, the commentators, listen to the writer read aloud his/her piece. The fourth person is, of course the writer who reads. Each person in the group will take turns at reading, commenting and recording.

2. **Checklists** — These are lists of questions that can be handed to each person in a group or in duads. These questions address three general problems which occur in writing. The Writing Center™ comes with several revision checklists.

**EDITING STRATEGIES**

Editing is the correction of the technical aspects of the written word: spelling, grammar, punctuation and paragraphing. Checklists are a great help in this area. The Writing Center™ comes with several editing checklists.
A SAMPLE BUBBLE OUTLINE

Categories:
Activities - Sports, bicycles, the park
Weather - rain, warm weather

Spring
Summer is near

The park
Clothes
Vacation
Bicycles

Easter
Flowers
Warm weather

Sports
Rain

A "Keys To Literacy" Project Of The UFT/NYCTCQ®
The Reading Writing Connection

Page 77
**SAMPLE REVISION CHECKLISTS FROM THE WRITING CENTER™**

**Planning My Time**

Using the chart below, estimate the amount of time you will need to spend on each major step in writing a report. Then add up those numbers to see a total of the estimated time you will need. Divide that total among the number of days left to see roughly how many hours you will need to spend each day.

Be realistic. Remember, your other activities continue—chores, schoolwork, homework, family occasions, religious and community activities, sports, parties, and so on.

Don't plan to work on your report for more than three or four hours at a time. Most people tire and lose concentration after a few hours of reading or writing.

Today's date:
Date report is due:
Number of days left:

<table>
<thead>
<tr>
<th>Typical Time for Each Step in Report Writing</th>
<th>My Estimated Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step in Writing a Report</td>
<td>Simple</td>
</tr>
<tr>
<td>Pick a Topic</td>
<td>&gt; 10 pgs</td>
</tr>
<tr>
<td>Locate Sources in the Library</td>
<td>1 hr</td>
</tr>
<tr>
<td>Read Sources and Take Notes</td>
<td>2-3 hrs</td>
</tr>
<tr>
<td>Make an Outline</td>
<td>4-6 hrs</td>
</tr>
<tr>
<td>Write a First Draft</td>
<td>1-2 hrs</td>
</tr>
<tr>
<td>Revise</td>
<td>3-8 hrs</td>
</tr>
<tr>
<td>Make the Final Copy</td>
<td>2-6 hrs</td>
</tr>
<tr>
<td>TOTAL</td>
<td>&gt; 20 pgs</td>
</tr>
<tr>
<td></td>
<td>1 hr-1 day</td>
</tr>
<tr>
<td></td>
<td>3-5 hrs</td>
</tr>
<tr>
<td></td>
<td>6-8 hrs</td>
</tr>
<tr>
<td></td>
<td>2-4 hrs</td>
</tr>
<tr>
<td></td>
<td>8-12 hrs</td>
</tr>
<tr>
<td></td>
<td>6-8 hrs</td>
</tr>
<tr>
<td></td>
<td>2-6 hrs</td>
</tr>
</tbody>
</table>

For Use with The Writing Center™ from The Learning Company®

**CHECKLISTS ARE FROM THE WRITING CENTER™**

A "Keys To Literacy" Project Of The UFT/NYCTCC®
Making An Outline

The Writing Center makes it easy for you to make a neat outline with everything lined up. To see how the outline below was made, look at the paragraph-margin and Tab Stop settings on the Ruler. If the Ruler is not visible, choose Show Ruler in the Preferences dialog box from the Edit menu. Make the Tab markers and Return-key presses visible in the outline by choosing Show Invisibles in the Preferences dialog box. Only paragraph-margin settings, Returns, and Tabs were used to make this outline. The Spacebar was used only to put spaces between the words in the headings.

If you like, you can simply replace the words in the outline below with those for your own report outline. After you type in your own words, choose Save As from the File menu to save this document under the name you want your outline to have, in your report folder.

Title

I. Opening
II. First Main Point or Idea
   A. Supporting detail
   B. More supporting detail
III. Next Main Point or Idea
   A. Supporting detail
   B. More supporting detail
   C. More supporting detail
IV. Last Main Point or Idea
   A. Supporting detail
   B. More supporting detail
   C. More supporting detail
V. Conclusion

For Use with The Writing Center™ from The Learning Company®

Checklists Are From The Writing Center™

A "Keys To Literacy" Project Of The UFT/NYCTCC ©
SAMPLE REVISION CHECKLISTS FROM THE WRITING CENTER™

Name
Date
Teacher

First Draft Checklist

Answer each question on this checklist either Yes or No. If your answer to any question is “No” or “I’m not sure,” list that part of the report as a part that needs to be changed.

________ Does the opening catch your attention and give you a good idea of what’s to come?

________ Do the sections and subtitles match the outline?

________ Are the points in logical (sensible) order?

________ Does each main point come across clearly?

________ Do the supporting details convince you that the main points are true?

________ Can you tell when one main point ends and another begins?

________ Does the conclusion of your report summarize your overall message?

For Use with The Writing Center™ from The Learning Company®

CHECKLISTS ARE FROM THE WRITING CENTER™

A "Keys To Literacy" Project Of The UFT/NYCTCC®

The Reading Writing Connection
SAMPLE REVISION CHECKLISTS FROM THE WRITING CENTER™

Name
Date
Teacher

Final Draft Checklist

Put a check mark ( ) next to each item when you’ve completed it in your report.

Completeness
Check that your report includes:
- cover
- title page
- table of contents
- outline, if one is required
- text of the report
- endnotes
- bibliography
- note cards and bibliography cards, if these are expected
- each of the above parts starts on a new page

Title Page
Check that the title page includes:
- title
- your name as author
- name of the person assigning the report
- name of the class
- date

Table of Contents
Check that the table of contents includes:
- all the chapter titles and main section headings (subtitles) in the text of your report
- all the main points in the outline (as section subtitles)
- page numbers that match with the proper pages of the text

Outline
Check that the outline
- is complete.
- is in the proper form.

A "Keys To Literacy" Project Of The UFT/NYCTCC®
SAMPLE REVISION CHECKLISTS FROM THE WRITING CENTER™

Text of the Report

Does each section have a subtitle? Are the subtitles in larger type, boldface type, or underlined to separate them from the text?
Are all your subtitles matched in placement, size, font, and style?
Are all your pictures, drawings, and charts placed near the text they go with?
Are your pages numbered? Numbered correctly?
Is the text double-spaced?
Is the first line of each paragraph indented one-half inch?
Does each sentence start with a capital letter and end with the proper punctuation?
Are all sentences complete sentences?
Do you use the same verb tense throughout the report? The tense should all be present tense or past tense.
Have you capitalized all names of special places, people, and events?
If you used a pronoun (especially it, they, or them), is there any doubt about what the pronoun refers to?
Are all words spelled correctly? Did you use the Spelling Checker?

Endnotes

Does each endnote number in the text have a corresponding entry on the list of endnotes?
Are your endnotes accurate?
Is the source for each endnote listed in the bibliography?

Bibliography

Do you have enough endnotes and bibliographical references to satisfy the requirements of the assignment?
Is your bibliography in alphabetical order?

For Use with The Writing Center™ from The Learning Company®

CHECKLISTS ARE FROM THE WRITING CENTER™

A "Keys To Literacy" Project Of The UFT/NYCTCC®

Page 83

The Reading Writing Connection
Sample Editing Checklists From The Writing Center™

Paragraph Editing Checklist

Answer each question on this checklist either Yes or No. If your answer to any question is "No" or "I'm not sure," list that part of the report as a part that needs to be worked on.

Does each paragraph have a topic sentence?
Are your supporting details convincing?
Are the supporting details in logical (sensible) order?
Have you tried to add special details or lively quotes?
Did you take out all dull or unnecessary information?
Have you removed sentences that don't belong with the others?
Can your reader tell when you are about to move from one main point to the next?

Checklists Are From The Writing Center™

A "Keys To Literacy" Project Of The UFT/NYCTCC®

Page 84
**Sample Editing Checklists From The Writing Center™**

Name
Date
Teacher

**Word Editing Checklist**

Put a check mark (✓) next to each item when you've completed it in your report.

- Replace abstract nouns with ones that you can picture in your mind. For example, use "books" instead of "reading materials."
- Replace "to be" verbs with action verbs. Change passive statements to active ones. For example, "Houses were built by groups of men" would be changed to "Groups of men built houses."
- Use vivid, colorful words.
- Take away words that don't say much—like very, really, lots, maybe, perhaps, and almost.
- Shorten quotes to include only the best parts.

For Use with The Writing Center™ from The Learning Company®

**Checklists Are From The Writing Center™**

A "Keys To Literacy" Project Of The UFT/NYCTCC®
The Elements Of Design & Layout

A "Keys To Literacy" Project Of The NYCTCC©

The Elements Of Design & Layout
SESSION 6: ELEMENTS OF DESIGN

A. THE READING PROCESS IN THE DESIGN OF MATERIAL OR
HOW PEOPLE READ PRINTED MATERIALS

THE THREE STAGES OF RELEVANCY

1. In the first seven seconds, a person will become interested in the material or they will not.
In the first stage, people will ask themselves "Is this relevant? Should I go on with reading this material?"
Relevancy is determined first through
A. Headlines (show examples)
B. Subheads (show examples)
C. Photos & Captions (not just for identification of people but to make a point or to sell an idea –to elicit curiosity)(show examples)

2. In the next thirty seconds, people will read onto be reassured that they weren't wrong. They are led to ultimate relevancy.
This is reinforced by
A. Short Body Copy
B. Non-Photographic Art
   • diagrams
   • charts
   • clip art
   • graphics with captions
C. An Outline Format
   • Table of Contents
D. Graphic Devices
   • dotted lines
   • bullets
   • boxes
   • rules (lines which tell about connected material)

A "Keys To Literacy" Project Of The NYCTCC®
SESSION 6: ELEMENTS OF DESIGN

3. The third stage of relevancy is the action stage where the designer wants the audience to get into the material. This is accomplished by
   A. Long sections of body text
   • Copy – "we have a lot to say"
   B. Proof
   • Statistics
   • Endorsements
   • Testimonials

B. DESIGNING LAYOUT

Layout and Design is the plan and components or elements of what you want on the printed page.
In planning for any publication:
   A. Identify your objectives
      • What do you want to achieve
        (eg. In my flyer, I want to appeal to my audience to attend the conference)
   B. Quantify your objectives
      • Demonstrate something quantifiable
        (eg. I want 50% of my readers to attend the conference)
   C. Assess your audience
      • Psychographic Factors
        - Maximum visual suitability
        - Audience appeal
        - Life style factors
        - Value of imagery
        - Conveyance of information
        - Moving to action

FACTORS TO CONSIDER IN LAYOUT OF MATERIAL ARE

• Designing for action and information
• Strongest point usually in the center of the page (attention-getting)
• Bigger is always better
• Avoid panelization

A "Keys To Literacy" Project Of The NYCTCC®
ELEMENTS OF DESIGN (CONT'D)

1. BALANCE (symmetrical/assymetrical)
   A. LARGE is more powerful and has more optical weight
   B. COLOR has more weight
   C. UNUSUAL SHAPES have more weight
   D. WHITE OR EMPTY SPACE has more optical weight

To ascertain whether or not the page is balanced side to side, cover half the page.

2. PHYSICAL SYNTAX (How the eye travels on the page)
   A. The eye goes above the left of center first.
   B. The eye then travels to the upper left-hand corner.
   C. Next, the eye travels to the upper right-hand corner.
   D. After this, the eye heads down the page to the lower left-hand corner, known as the dead zone.
   E. The eye then leaves the page at the lower right-hand corner

3. UNITY - within a piece or series of pieces
   This element involves decisions about handling various elements like
   A. Column and division of space
   B. Color and white space
   C. Logo
   D. Format of piece

4. PROPORTION - the division of space on the page
   A. Use of the grid (breaking up space either vertically or horizontally
   B. Know your audience
   C. Develop a format

5. CLARITY -
   A. A clear message
   B. Include phone, address coupon
   C. Perception that it is easier to read

6. EMPHASIS - The first, second or third thing the reader sees should be the most important element on layout page otherwise the emphasis is wrong.

7. PROOF COPY - For objectivity, have someone who is not part of your department look at the copy.
**ELEMENTS OF DESIGN (CONT'D)**

Rules Of Thumb

1. Once you achieve a design, don't change it.
2. You will sacrifice unity of peace and message.

Some Reasons For Change

1. Change of administration
2. Convey a different message (philosophical position, image position)

**NOTES**

A "Keys To Literacy" Project Of The NYCTCC®
THE UNITED FEDERATION OF TEACHERS
The New York City
Teacher Centers Consortium

48 East 21 Street New York, NY 10010 (212) 475-3737 Myrna Cooper, Director

A PORTFOLIO OF PROJECTS FOR THE MACINTOSH COMPUTER & THE WRITING CENTER™ IN THE ONE COMPUTER CLASSROOM

Permission granted to copy for educational uses only. Copyright© Tom Snyder Productions, Inc.

A "Keys To Literacy" Project Of The UFT/NYCTCC©
ATTENTION!

The instructions for the projects in this Portfolio are meant to be used in conjunction with the instructions in The Mac Pack and A Guide To The Writing Center™. This is done to prevent duplication and redundancy, to reinforce the steps necessary for performing functions with the Macintosh computers and The Writing Center™ and to provide you with a stepwise system of proceeding through this Portfolio Of Projects.

You will find that the projects for each session are cross-indexed with the instructions for each session in The Mac Pack and A Guide To The Writing Center™ for easy referencing. The other packets included in this workshop are likewise cross-indexed by session.

What Can a Good Teacher Do With a Computer?

- Manage responsibilities and paperwork
- Make dazzling presentations
- Lead incredible discussions
- Manage dynamic cooperative learning activities
- Inspire enlightening self-discovery

Permission granted to copy for educational uses only. Copyright © Tom Snyder Productions, Inc.
SESSION 3: PROJECT # 1 — PART A:
CREATING A CLOZE EXERCISE

In this Project, you will set all of the defaults for creating a Cloze Exercise Template by following these steps:
- Launching The Writing Center™
- Selecting a Report Template Without A Heading.
- Setting Preferences.
- Bordering the page.
- Setting the columns.
- Setting the tabs.
- Setting the text alignment.
- Setting the line spacing.
- Saving the document into your folder.

INSTRUCTIONS:
(The detailed instructions for the following operations will be found in A Guide To The Writing Center™ – Session 3, pages 2-10)

A. Launch The Writing Center™
B. Select Report Without Heading Document Template
C. Setting Defaults
   - Preferences — Make sure the ruler is selected.
   - Page Setup
     1. Set Margins for .5 inches all the way around the page.
     2. Set Page Border for all sides, double line and shadow
     3. Set for no columns
   - Ruler
     1. Set .5 inch Tab
     2. Set for Single Space
     3. Set for Justified Text
D. Save Your Document
   - Name it Cloze Exercise (include your initials — e.g. Cloze Exercise R.V.B.)
   - Save into Your Folder
E. Quit The Program
F. Shut Down The Computer

Permission granted to copy for educational uses only.
Copyright © Tom Snyder Productions. Inc.

A "Keys To Literacy“ Project Of The UFT/NYCTCC®

Page 94
SESSION 4: PROJECT #1 — PART B
CREATING A LANGUAGE ARTS CLOZE EXERCISE

In this Project, using your students' work, you will add & change text to the Cloze Exercise Template you made in Session 3 to create A Language Arts Cloze Exercise by following these steps:

- Opening a Saved Document
- Typing the title Clozing In On Nouns at the top of the body.
- Typing your students' work in the Body.
- Changing the text alignment.
- Changing the line spacing
- Changing the font, style & color.
- Placing a border around the Word List.
- Blanking out all Nouns in the students writing.
- Saving this document onto a floppy disk.

INSTRUCTIONS:
(The detailed instructions for the following operations will be found in A Guide To The Writing Center™ — Session 4, pages 11-14)

A. Launch The Writing Center™
B. Open a Saved Document.
- Select Close Exercise (your initials are added to it)
C. Typing a Title
- Click in top of body and type Clozing In On Nouns
- Change the font of the Title to Helvetica 24, Bold & Shadow.
D. Typing Body Text
- Type your students' work into the body beneath the title.
- Change body type to Palatino 12.
- Change text alignment to Flush Left.
- Change line spacing to double space.
- Blank out all Nouns by using the underline key (Shift + _).
- Type in all blanked out Nouns beneath title.
- Put a double-line border around the Nouns.
E. Saving
- Save
- Save to floppy disk
F. Print
G. Quit
H. Shut Down

Permission granted to copy for educational uses only. Copyright © Tom Snyder Productions, Inc.

A "Keys To Literacy" Project Of The UFT/NYCTCC®

Page 95 A Portfolio Of Projects
SESSION 5: PROJECT # II
CREATING A "MAKE A STORY TEMPLATE"

In this Project, using your students' work, you will create a "Make A Story Exercise" by following these steps:

- Launching The Writing Center™
- Opening a New Document
- Selecting a Report Template Without A Heading.
- Setting Defaults
- Choosing and placing appropriate graphics into the body of a document.
- Saving this document onto the hard disk & a floppy disk.

INSTRUCTIONS:
(The detailed instructions for the following operations will be found in A Guide To The Writing Center™ — Session 5, pages 15-20)

A. Launch The Writing Center™
B. Open a New Document.
C. Select Report Without Heading Document Template
D. Setting Defaults
   - Preferences — Make sure the ruler is selected.
   - Page Setup
     1. Set Margins for .75 inches all the way around the page.
     2. Set Page Border for top & bottom only, triple line border and black lines.
     3. Set for no columns
   - Ruler
     1. Set .5 inch Tab
     2. Set for Double Space
     3. Set for Flush Left Text
E Adding Graphics
   1. Select the picture entitled "storm" from the Nature/Science folder in The Writing Center™ graphics folder.
   2. Place in the body — following the model.
F. Save Your Document
   1. Name it Make A Story (& add your initials).
   2. Save into Your Folder.
G. Changing Graphics
   1. Flip the graphic.
   2. Place a single-line border around the picture.
H. Type in text using model.
I. Save Your Document.
J. Save To disk.
K. Print
L. Quit The Program.
M. Shut Down.

A "Keys To Literacy" Project Of The UFT/NYCTCC

Page 96
A Portfolio Of Projects
SESSION 6: PROJECT #11
CREATING A MYSTERY PICTURE - USING THE "VISUAL-VERBAL" CONNECTION WITH MATHEMATICS

In this Project, using a model from The Writing Center™ and the Elements of Design and Layout, you will add & change text and graphics to create a Mystery Picture Exercise by following these steps:

- Opening a New Document
- Typing in the Heading.
- Typing in the Body.
- Changing the text.
- Changing and adding graphics to create interest and to use as a motivator
- Design an eye-catching layout using the principles of design and layout.
- Saving this document onto the hard disk & floppy disk.

INSTRUCTIONS:

A. Launch The Writing Center™
B. Open a New Document.
   • Select Report With Heading
C. Typing a Title in the Heading
   1. Click in heading and type: Mystery Picture
   2. Change heading type to Chicago 24, Shadow & Underline.
   3. Border the heading all around with a single-lined shadow.
D. Typing Body Text
   4. Using the model as a guide, choose four of the questions and type in the text for the Mystery Picture Exercise.
   5. Change body font to Monaco 12.
   6. Change text alignment to Flush Right.
   7. Double Space text.
   8. The Key for the Mystery Picture should be bold and have a double-line border.
E. Save
F. Adding and Changing Graphics
   1. Select an appropriate picture for each of the questions from the picture folder and add to the body.
   2. Crop and Resize each Picture to make it fit.
G. Elements of Design & Layout
   1. Balance the graphics by making sure one is one either side of the page.
   2. Balance the text with the graphics by making sure it is not chopped up in an inappropriate place.
H. Save
I. Save to floppy disk
J. Print
K. Quit
L. Shut Down

A "Keys To Literacy" Project Of The UFT/NYCTCC®
SESSION 7: PROJECT # IV
CREATING A SCIENCE NEWSLETTER

In this Project, using the students’ Science writing, you will design from scratch, A Science Class Newsletter by following these steps:

- Launching The Writing Center™
- Opening a New Document
- Selecting a Custom Template With A Heading
- Setting Defaults
  - Choosing and placing appropriate graphics into both the heading and body of the newsletter.
- Saving this document onto the hard disk & a floppy disk.

INSTRUCTIONS:
(The detailed instructions for the following operations will be found in A Guide To The Writing Center™ - Pages 5-20)

A. Launch The Writing Center™
B. Open a New Document.
C. Select the Custom Template
D. Setting Defaults
  - Preferences — Make sure the ruler is selected.
  - Page Setup
    1. Set Margins for .50 inches all the way around the page.
    2. Set Page Border for all sides, triple line border and shadowed.
    3. Set for 2 columns
  - Ruler
    1. Set .5 inch Tab
    2. Set for Single Space
    3. Set for Justified Text
E. Adding Graphics
  1. Select an appropriate picture.
  2. Place in the heading.
  3. Select 2 appropriate pictures for the body.
  4. Place in the body.
F. Save Your Document
  1. Name it.
  2. Save into Your Folder.
G. Changing Graphics
Session 7: Project # IV (Cont'd)

1. Place a single-line border around the Heading Text.
2. Place a single black line border completely around each of the 2 body graphics.

H. Save Your Document.

I. Typing In The Text
1. Select Palatino 10 for the body text.

J. Balancing the Newsletter
1. Place the graphics where they will look balanced. Use the "half-page" test — cover one half and see whether or not it appears to be balanced with the text.
2. Share your newsletter with the person next to you to test for readability.

K. Save To disk.
L. Print
M. Quit The Program.
N. Shut Down.

Q: WHAT'S THE MOST EFFECTIVE TEACHER-PUPIL RATIO?

A: ONE-TO-ONE

A "Keys To Literacy" Project Of The UFT/NYCTCC®
SESSION 8: PROJECT #5
CREATING A BUBBLE OUTLINE

In this Project, you will create a bubble outline to use in your classes by following these steps:

- Launching The Writing Center™
- Opening a New Document
- Selecting a Report with no Heading Template
- Setting Defaults
- Saving this document onto the hard disk & a floppy disk

INSTRUCTIONS:

A. Launch The Writing Center™
B. Open a New Document.
C. Select the Report with no Heading Template
D. Setting Defaults
   - Preferences — Make sure the ruler is selected.
   - Page Setup
     1. Set Margins for .50 inches all the way around the page.
     2. Set Page Border for all sides, single line border and shadowed.
     3. Set for no columns
   - Ruler
     1. Set .5 inch Tab
     2. Set for Double Space
     3. Set for Centered Text
E. Adding Graphics
   1. Select an appropriate picture from the picture folder.
   2. Place in the document.
   3. Resize to enlarge.
   4. Place in the body.
F. Save Your Document
   1. Name it.
   2. Save into Your Folder.
G. Changing Graphics
   1. Place a double-lined, shadow border around the graphic.
H. Save Your Document.
I. Typing In The Text
   - Type words which go with the picture. Place them in various positions around the page (Use Model).
   - Use the font Palatino 12 bold.
J. Save To disk.
K. Print
L. Quit The Program.
M. Shut Down.

A "Keys To Literacy" Project Of The UFT/NYCTC®
Lecturette — Research has shown that computers can ease the administrative burdens that are placed on the classroom teacher. The following chart shows a comparison of the amount of time it took an actual teacher to do the grades by hand and by computer for a class of 30 students.

<table>
<thead>
<tr>
<th>Task</th>
<th>By Hand</th>
<th>Electronic Gradebook</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter class list.</td>
<td>10 min</td>
<td>10 min</td>
</tr>
<tr>
<td>Alphabetize class list.</td>
<td>3 min</td>
<td>1 sec</td>
</tr>
<tr>
<td>Write grades.</td>
<td>2 min</td>
<td></td>
</tr>
<tr>
<td>Average grades (17 tests, 5 categories, exam weighted)</td>
<td>40 min</td>
<td>2.5 min</td>
</tr>
<tr>
<td>Provide detailed progress reports.</td>
<td>10 min</td>
<td>20 sec</td>
</tr>
<tr>
<td>Prepare frequency distribution.</td>
<td></td>
<td>2 min</td>
</tr>
<tr>
<td>Statistical analysis means standard deviation, item analysis</td>
<td>30 min</td>
<td>20 sec</td>
</tr>
<tr>
<td>Total time</td>
<td>8 min</td>
<td>15 min</td>
</tr>
</tbody>
</table>

Note: These results indicate savings of more than an hour for this one class during a single grading period.


Permission granted to copy for educational uses only. Copyright © Tom Snyder Productions, Inc.
Class lists: Using a software program that has the ability to create a database makes record keeping easy. (Using Claris Works database demonstrate creating class lists).

- Open Claris Works
- Choose Data Base Button
- Define fields dialog box appears

• Type a field name in the box — Click create box after each field name class
  last name
  first name
  street
  city
ADMINISTRATIVE TASKS & CLARIS WORKS ® (CONT’D)

State
zip
telephone number
parent / guardian

- Click a Field Type - Click Text
- Click done

class
last name
first name
street
city
state
zip
telephone #
parent 1

- Press Command R to repeat fields

Change from file card to list:
- Choose New Layout from layout menu
- Click Columnar Report
- Click OK
- Move field list over to field order
- Click OK
- Fields appear as a list

Two Sides of Teaching

A "Keys To Literacy" Project Of The UFT/NYCTCC©
**Electronic Grading Book:** Using a software program that has a spreadsheet feature allows you to:

- Design your own grading book
- Quickly find where students stand in middle of the marking period
- Average grades

Using Claris Works spreadsheet demonstrate the creation of electronic grading book

- Open Claris Works
- Select spreadsheet button - following appears
- Select a cell
- Type in data
- class -names -test marks
- Demonstrate addition, multiplication, division & averaging
ADMINISTRATIVE TASKS & CLARIS WORKS © (CONT'D)

• Demonstrate the use of the spreadsheet in
  creating a seating plan
  ease of changing seats
  cooperative learning seating arrangements

Getting Parents Involved

Using the word processing component of your software program you can:

• Create form letters to parents
  change names as needed
  revise information about student
  anecdotal record of student work
  invitations to class projects
• Once created minutes to change & print out
• Mail Merge
REVIEW SHEETS FOR THE MACINTOSH & THE WRITING CENTER™
Session 1 Review

A. Answer These:

1. What is the desktop?
2. What is an icon?
3. What is a window?
4. How do you open a window?
5. How do you close a window?

B. Create and Name a folder.
To review what you learned in Session 2, complete the following

**Part A — Setting The Alarm Clock**

- Set the alarm clock to 15 minutes past the present time (see pg. in Mac Pack for Instructions)
- When alarm rings, remember to ____________________________

**Part B — Calculator**

- Do the following examples on the calculator

```
27.41  x  5  3281  4310  6898/29  +2800  4943  -3214
```

**Part C — Control Panel**

- Change highlight color
- Change desktop screen color
Session 3 Review

The Writing Center™
1. You launch The Writing Center™ by__________________________
2. The margins are set in the__________________________
3. You can put borders around__________________________
4. The three types of templates are__________________________
5. The dialog box which contains the command to show the ruler is the__________________________
The Writing Center™
1. With The Writing Center™, you can create___________________________
   and__________________________.
2. Before typing in text or selecting pictures, you must choose a
   ________________________________.
3. The two parts of a document where text and pictures may appear are the
   ___________________________ and the ___________________________.
Session 5 Review

Using Graphics

1. If a picture is too large, the two operations you can perform to change it are ___________ and ___________.
2. If you wish to turn a picture, what two commands can you use? In which Menu are they to be found? _________________________.
3. If you wished to put "frame" a picture, you could select ___________ from the ___________ menu.
Session 6 Review

Reading Habits & Elements of Design

1. Two important items to consider when designing a piece of printed material are _______ and ________.

2. What size font is the smallest, easily readable size? ________

3. A ________ font should be used for headlines and a ________ font should be used for body text.

4. Three psychographic factors in designing a newsletter are ________, ________, and ________.

5. When you begin to read a page, where does your eye rest first? ________

6. One way to get the reader to turn a page is to ________

---

A "Keys To Literacy" Project Of The UFT / NYCTCC®
Session 7 Review

Make An Award Exercise

1. Study the model.
2. Open a new Document.
3. Select "Report With No Heading".
4. From the Picture Menu select an
5. Type a one paragraph story based on this picture. Leave out why, who, when, where, what, and how as in the model.
6. Save into your folder.
7. Print.
The Writing Process

1. The three parts of the writing process are ____________, ____________, and ____________.
2. Two similarities between reading and writing are ____________ and ____________.
3. Two ways wordprocessing programs help children to write are ____________ and ____________.
4. How would the Time-Line pre-writing strategy help a youngster prepare to write a composition? ____________

5. What strategies could you employ to have your students zero in on revision problems in a piece of writing?
Handouts & Transparency Masters For The Macintosh & The Writing Center™ In The One Computer Classroom

A "Keys To Literacy" Project Of The UFT/ NYCTCC®
Session 6: Using Text & Graphics In A Layout
Reading Patterns

Eye flow and eye dwell describe our natural reading patterns. Using tools such as placement and emphasis, designers can choose either to work with or against these patterns.

Optical Center

When scanning, the eye starts at the optical center of the page (slightly above and to the left of the mechanical center).

Eye Flow

The eye then sweeps left to right, tracing a lazy z pattern across and down the page.
Reading Patterns (Cont'd)

Eye Dwell
Studies have shown that the eye dwells different amounts of time in each quadrant of the page.

![Diagram with percentages: 35%, 25%, 15%]
Text Design: Working With Type

Legibility/Readability

Legibility

Readability

Serif/Sans Serif-

Serif:
1. Century School Book
2. Bookman
3. Palatino

Sans Serif:
1. Eurostile
2. Geneva
3. Avant Garde
4. Helvetica

Justified/Ragged
6 Foundational Concepts of Layout Design

1. Balance

2. Eye Rhythm/Visual Syntax

3. Unity

4. Proportion

5. Clarity

6. Emphasis
3 Stages of Readership

Stage I – Relevant – 1 - 7 Seconds

1. Headlines/Titles
2. Photos/Captions

Stage II – Ultimate Relevance – 90 Seconds

1. Short Copy
2. Non-photographic Art
3. Outline Format
4. Graphic Devices

Stage III – Action – No Time Limit

1. Long Body Copy
2. Proofs/Testimonials